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Introduction to ArcGIS Online, StoryMaps and editing your online 
mapping portal 

V4 January 2020 

 

COURSE OBJECTIVES: 

After completing this course, you will: 

• Understand what ArcGIS Online is, what it can be used for and how to manage your account 

• Understand how to find and use data, and how to upload and share your own data 

• Know how to create, edit and manage your catchment story map 

• Be able to combine multiple datasets and content into an engaging catchment portal 

• Understand how to use tools such as ArcGIS Survey 123, Collector and Dashboards to support 

collaborative working 

• Be inspired by how others in the CaBA network are using ArcGIS Online to develop collaborative 

catchment plans 

  

   

This is a technical training manual aimed at CaBA partnership and rivers trust staff with some GIS Desktop 

experience who want to learn how to use ArcGIS Online (AGOL) and StoryMaps to publish online maps and 

apps and develop a catchment portal. By the end of the course you should be able to use AGOL to create 

and share online maps and have confidence in using and editing your own catchment Story Map. 
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 INTRODUCTION TO ARCGIS ONLINE 

 

What is ArcGIS Online (AGOL)? 
• Cloud based GIS content management system by 

ESRI (Environmental Systems Research Institute)  

• Access data, maps, tools and apps (don’t need 

desktop GIS software to view and use maps and 

apps) 

• Upload data and share with others 

• Create maps and applications using the ArcGIS 

Online templates  

• Secure access – restrict access to sensitive content if required 

• ArcGIS Online public account is free, but if you want to publish your own data, maps, and apps you need 

an organisational subscription (free with an ArcGIS desktop non-profit license (ca. £120 p.a. for charities) 

• Storage and processing of data uses Service Credits – you get a certain amount free and can buy bundles 

of additional credits if required. See here for more info on service credits: 

https://www.esri.com/software/arcgis/arcgisonline/credits  

Benefits to CaBA partnerships of ArcGIS Online Organisational Subscription 
• Extend the power of GIS – more people can access your content 

• Break down silos – share between partner organisations  

• Control access – decide what you share with who 

• Low cost for charities – £120 p.a. is affordable for host organisations 

• Easy to publish maps and apps (no coding required) 

• Access to CaBA data and map templates – we’ve done a lot of the work for you 

• Free technical support available (ESRI and CaBA) – we can help you get the most out of AGOL 

Limitations of ArcGIS Online 
• AGOL works best with fast, reliable broadband connections and some apps will only work on large 

screens. 

• Cartographic design options and printing are limited compared to desktop GIS  

o The cost of speeding up sharing and display in AGOL is that labelling, line and polygon 

symbology, resolution and other layout items are limited 

o If you need a high-resolution, cartographically sophisticated map then use desktop GIS – you 

have a lot more control over the way you can display and print maps 

  

https://www.esri.com/software/arcgis/arcgisonline/credits
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Structure of ArcGIS Online 
 

Datasets and Layers 

The first tier of the AGOL structure – these are the individual geographic information layers or content 

• Data services are stored and shared online (AGOL, cloud or web servers) 

• Based on international standards so that different software platforms can share data 

• Storage and processing of your own data on your AGOL account uses service credits, but using other 

people’s data is generally free (unless it is premium content – see below) 

• Vector or feature services are ‘intelligent’ – users can query and analyse the data, but these can slow 

down map display and use a lot of storage space if you publish your own 

• Raster layers (aka. web mapping services or tile mapping services) are view-only but display quicker and 

don’t use so much storage space 

• It is possible to combine datasets from multiple sources both ArcGIS Online and other web GIS systems 

(own data, organisation data and others’ data) 

• Datasets are updated and shared by data custodian = instant access to updates and no need to download 

a copy – just ‘plug and play’ 

• Descriptions, metadata, tags, attribution, all help share the purpose and limitations of data if people 

include this (make sure you do when you publish your own data!) 

However…. 

• Anyone can publish their data so finding reliable data can be tricky 

• Best to use authoritative datasets from organisations you know and 

trust in published maps and apps (less likely to disappear or be 

changed) 

• Use the CaBA data package and Living Atlas – these are curated data 

sources and often have symbology, popups and labels done for you 
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• Look at the publisher and the item details for more info  

• You may need desktop GIS software to publish your own data to AGOL 

• Not all online data is free to use and share with others -subscriber 

content is only accessible via an AGOL account and premium content 

uses service credits when you access it.  There are ways to add these 

types of data to your public maps and apps – see here for more info on 

using subscriber and premium content: 

https://blogs.esri.com/esri/arcgis/2015/07/17/using-subscriber-content-in-web-apps/  

 

Maps 

The middle tier of the AGOL structure – maps are where you decide on the look and feel of the layers  

• Combine layers and decide on display order 

• Set colour and symbol of points, lines, and polygons 

• Change transparency of layers and scale at which they become visible 

• Configure ‘popup’ information when user clicks on map 

• Add labels to features 

• Edit layer names and decide which layers to show in the map legend 

• Decide which feature attributes are visible in the table and popups 

• Filter features based on attributes or spatial location 

 
Apps and ‘StoryMaps’ 

The top tier of the AGOL structure – apps are the end user interface and 

determine how people can interact with your data and maps – use these to 

tell a story with data, gather new data and allow people to fully explore and 

customise your maps. 

• Esri provide a StoryMap template containing a wide range of functionality 

to present your data and narrative. 

• Examples of StoryMaps in this template can be found on the AGOL 

website: https://www.esri.com/en-us/arcgis/products/arcgis-

storymaps/stories You can also find examples of catchment StoryMaps on the CABA website, however 

please note that the majority of these examples use an older version of StoryMaps: 

https://data.catchmentbasedapproach.org/   

• Customise with organisation branding and suit your end user requirements 

• Can include lots of non-geographic content like text, video, images, web pages, etc. 

• Easily present the same data and maps to different audiences – for example use a simple story map with 

clear narrative and no jargon for a public audience, whilst sharing a separate app for your catchment 

https://blogs.esri.com/esri/arcgis/2015/07/17/using-subscriber-content-in-web-apps/
https://www.esri.com/en-us/arcgis/products/arcgis-storymaps/stories
https://www.esri.com/en-us/arcgis/products/arcgis-storymaps/stories
https://data.catchmentbasedapproach.org/
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partnership which could include more technical information and allow them to add their own data or 

projects to the map 

Sharing your Content 
Everything that you and others store on AGOL (data, maps, apps) can be shared in several ways: 

 

• Not shared – this is the default setting, so you must actively decide to share your content before others 

can see it 

• Organisation – you can decide only to share 

with other AGOL users who have access to your 

organisational account. This might be suitable 

for sensitive or restricted data which you need 

to protect with a password. 

• AGOL Groups – you can share outside of your 

organisation with a restricted set of AGOL users 

from other organisations, but they need an 

organisational account and will need to be 

logged in to that account to see content. 

Alternatively, you can share data publicly and 

in a group as a way of collating content in one 

place – for instance the CaBA Online Data 

Package. 

• Public – this is the best way to share your content if possible, as everyone can access it without the need 

for an AGOL account.  Sharing with everyone will mean that anyone can search for and discover your 

data, maps, and apps. It is important to include as much information (metadata) about the source and 

purpose of your content, the terms of use and attribution in the item details page. 

 

Item Details (metadata)  
All AGOL content has an item details view which gives 

information on the type of content, publisher, summary 

description, tags, terms of use, attribution, publication 

date and more.  Item details are the way in which you as 

a content consumer can discover more about whether 

the content suits your purpose, but also the way that you 

as a publisher can communicate with a public audience 

and make your content more discoverable to others, so 

please take care to complete as much detail as possible 

to make your data as valuable as possible.  
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The CaBA Open Data Portal  

https://data.catchmentbasedapproach.org/ 

 
The CaBA open data portal has been developed and customised to be a ‘one stop shop’ for a range of 

resources to help CaBA partnerships access and share data more effectively. 

 

• CaBA Online Open Data Package: A curated set of 150+ catchment data layers which you can use in 

your own online maps and apps, as well as loading in ArcGIS desktop and ArcPro. These layers are 

hosted online and can be viewed either using ArcGIS Online or without any specialist software at all.   

Many can be accessed directly from the ‘owner’ of the data and therefore should be the most up to date 

version of that data. The real beauty of online data is that it can be combined with a narrative and 

shared with partners in ‘StoryMaps’ to underpin truly collaborative catchment management. The CaBA 

online data package is structured in the same way as the desktop package (e.g. opportunities, issues, 

characteristics, causes, actions and monitoring) and supported by a user guide. 

 

https://data.catchmentbasedapproach.org/
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• Many of the datasets are hosted on The Rivers Trust account, with symbology, labels, and popups all 

pre-configured to save you time.  You can filter many of these layers to your own catchment(s) to save 

you having to publish and host the data on your account. 

• Join the CaBA Online Data Package Group: AGOL users can request to join the CaBA Group making 

finding and loading data into your maps even easier. Click HERE to go to the Group AGOL page and click 

‘Join the Group’. 

• Download the User guide to help you interpret the data and how to use it for catchment planning.  

• Gallery of CaBA StoryMaps and apps – be 

inspired by what other partnerships have 

done and access some key national datasets 

via apps like the riparian shade explorer or 

CaBA data explorer. Please note, that the 

majority of these StoryMaps have been 

created using an older version of the 

StoryMaps template. 

• Licensing information - The fact that you can get hold of a dataset does not necessarily mean that you 

can do whatever you want with it. You need to have permission from the owner of that information to 

do what you want to do. The licensing pages combined with the user guide help you understand more 

clearly what you can and can’t do with the 

data.  

• Open Data – you can also download many of 

the datasets in different open data formats 

compatible with non-ESRI GIS software  

• Data previews and meta data available, 

attribute information and quick chart 

visualisation 

• Customised CaBA GIS Training resources for 

ArcGIS Online and ArcGIS desktop  

• Support Contact details for the CABA helpdesk and the discussion forum  
 
As well as the data available through this open data site, there are a number of datasets that are available 

for offline use only (due to licensing restrictions). You can see a full list of the datasets available in the 

guidance document. The offline data package is shared as a group of shapefiles (.shp) and layer files (.lyr) 

with a pre-configured ArcGIS Pro Project (.aprx) or ArcMap Document (.mxd). All catchment host 

organisations are entitled to request the data package for their CaBA catchment(s) by contacting 

info@catchmentbasedapproach.org . 

 
  

https://arcg.is/18iWyH
https://catchmentbasedapproach.org/wp-content/uploads/2020/05/CaBA_DataPackageGuidance_incl_Coastal_data_v5.4.pdf
mailto:info@catchmentbasedapproach.org
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Using online data in ArcGIS Desktop (ArcMap) 
You can ‘plug’ any of the datasets on ArcGIS Online in to any ESRI desktop products, including ArcMap and 

ArcGIS Pro, provided you connect to an AGOL account via a good internet connection.   

 

To connect to AGOL from ArcMap go to File> Sign In. 

and then input your AGOL username and password 

when prompted: 

N.B. even if you check the ‘Sign me in automatically’ 

box, ArcMap will still disconnect you from your AGOL 

account periodically as a security measure. 

You can tell whether you are still signed in to AGOL by 

checking the file menu, which will show Sign Out - 

<username> instead of Sign In… 

To add datasets from the Online CaBA Data Package to ArcMap, go to the Add Data dropdown menu and 

choose ArcGIS Online.  

This will open the AGOL window and 

you can search for a dataset by name, 

or you can browse the whole data 

package. To do this click on Groups 

and then double-click the CaBA 

Online Data Package Group to open it 

– here you will see all the most recent 

online CaBA data package layers: 

Click Details to read the full 

description or Add to load in the 

ArcMap viewer. 

 

If you are not already a member of this group you will need to request access by clicking Join This Group on 

the CaBA group homepage.  

This new group launched in 2019 supersedes the previous 

CaBA group and contains a complete refresh of the CaBA data 

package plus many new datasets. 
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Using online data in ArcGIS Pro 
ArcGIS Pro is the newest desktop GIS product from ESRI and is expected to replace ArcGIS Desktop in future. 

It is much more closely coupled with ArcGIS Online, so it is worth starting to use it if you haven’t yet tried it 

out. There are some training videos in the Links and Resources at the end of this manual.  

Make sure you have a map window open (Insert tab > New Map) ...once you have a map window go to the 

Map tab and select Add Data.  On the Add Data window click My Content to see your own AGOL data, All 

Portal to search the whole of ArcGIS Online or click Groups then CaBA Online Data Package to view the 

Online CaBA Data Package. Select a layer and click OK to add it to your map. 

 

Using online data in other GIS Software 
Datasets shared via the CaBA Open Data Portal are also available to download in a variety of different open 

formats for use in other GIS systems or software, including MapInfo and QGIS, with APIs available for use in 

web services. Please visit https://data.catchmentbasedapproach.org/ for more information. 

 

  

https://data.catchmentbasedapproach.org/
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 INTRODUCTION TO STORYMAPS 

What are StoryMaps? 
StoryMaps are web-based applications which allow you to combine maps and data along with narrative, 

images and other media. This combination means that you can share complex and wide-ranging 

information with your audience in an accessible and interactive way.  

There are many StoryMaps and web mapping templates available from ESRI. The focus of this guide is on 

the new generation of StoryMaps which have recently been launched by ESRI. For more information on the 

older generation of StoryMaps including the Journal, Series & Cascade templates, please refer to version 3 

of the Rivers Trust AGOL training HERE.   

StoryMaps used to be created using a wide range of available templates, all of which performed a slightly 

different function. Esri has recently replaced this system with a single new StoryMap template which in 

theory combines most of the elements of the ‘classic’ templates. This is still a work in progress and the new 

templates currently do not have the full functionality of the range of ‘classic’ templates, however they are 

improving all the time. The current classic Story Map templates will be phased out over the next few years 

as they focus on the new platform. The stories you have created with classic templates will continue to 

work over this period. If there is a specific function which is not available in the new template, it is still 

possible to access and create StoryMaps using the ‘classic’ templates: https://storymaps-

classic.arcgis.com/en/app-list/ 

The new generation of StoryMaps are very intuitive to use and have the added benefit of supporting mobile 

and tablet viewing. You will also continue to be able to add your existing maps and AGOL content to the 

new StoryMaps. Another useful feature of the new StoryMaps is that they can be grouped together in a 

‘Collection’ page. This can be helpful when you have several related StoryMaps, for example if you host 

several catchments and have individual StoryMaps for each one. Here is an example of a Collection Page.  

The development of the new generation of StoryMaps is extremely rapid, with new features and 

improvements being added by Esri almost every week. It is therefore likely that some of the information in 

this guide will be out of date in the near future. Please visit the Esri website to check for any StoryMap 

updates: https://doc.arcgis.com/en/arcgis-storymaps/reference/release-notes.htm  

Full details on how to create a StoryMap using the new template are covered later in this guide. 

 

 

 

 

 

 

https://catchmentbasedapproach.org/wp-content/uploads/2019/01/AGOL-Training-Notes-v2.pdf
https://storymaps-classic.arcgis.com/en/app-list/
https://storymaps-classic.arcgis.com/en/app-list/
https://storymaps.arcgis.com/collections/9d81757581bb4be68ce8de1510bbf923
https://doc.arcgis.com/en/arcgis-storymaps/reference/release-notes.htm
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 GETTING STARTED 

Before we start make sure: 

• You have access to the Rivers Trust AGOL training data group. You can join this group by going to the 

following page (https://arcg.is/1vGniq0), then clicking ‘Join this Group’. A group administrator will 

approve your request and you will then be able to access the training data.   

• You have logged onto the Wi-Fi network and have internet access 

Signing into your account 
STEP 1: Go to https://www.arcgis.com/home/signin.html and sign in with your Organisational Username and 

Password. This will open a window which looks similar to the image below. 

STEP 2: Click ‘Content’ on the header bar. This will open your contents window where you can find all the 

data, maps, and apps you have saved in your account. You can also access content saved in groups of which 

you are a member, and if you are an administrator content saved in other accounts for your organisation.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

STEP 3: Top Tip: Bookmark your contents page so you can easily return to it throughout the course! 

 

Joining the CaBA Online Data Package Group 
STEP 4: Click ‘My Groups’ on the header bar. You should see that we have invited and added you as a 

member of the CaBA Online Data Package Group. This gives you easy access to all the data layers published 

within the new (2019) CaBA Online data package. 

STEP 2 

https://arcg.is/1vGniq0
https://www.arcgis.com/home/signin.html
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If you do not currently have access to the CaBA Online data package, navigate to the data page on the 

Catchment based Approach website, scroll down to ‘Browse by category’ and click on the link which says 

‘Request Access’. Your request will be forwarded to a member of the Rivers Trust data and Evidence team 

who will approve the request. 

 

 

CREATING AN ONLINE MAP  

In this session you will create a simple map about flooding in the Tees Catchment. You will: 

• Learn how to add catchment data to an online map from a range of pre-existing sources including the 

online CaBA data package, Web Mapping Services (WMS), Excel spreadsheets and the Living Atlas, 

• Learn how to use AGOL to symbolise your map, configure pop-ups, filter data, and manage labelling 

• Learn how to update an existing map 

Create a new map and select a basemap 
STEP 1: Go to your AGOL Content page. To start developing a new map click the ‘Map’ tab at the top of the 

page. button and select ‘Map’. Click ‘OK’. This will then open the map workspace below. 

 

STEP 2: Use the search bar to zoom to your area of interest, in this case type ‘Darlington’ 

STEP 4 
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STEP 3: Select a basemap from the basemap gallery. We find that the topographic basemap gives a good 

backdrop to most maps. 

STEP 4: Save your map. You will need to add a title such as ‘Flooding in the Tees Catchment’, at least one 

key word tag e.g. Training, a simple description (this is optional) and save it into your AGOL Training folder. 

Remember to periodically resave your map throughout the map development process to avoid losing work 

should there be interruptions in internet service!    

STEP 2 

STEP 3 
STEP 4 
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Adding data from the CaBA Data Package 
STEP 5: Click the ‘Add Data’ button and then click ‘Search for layers’.  

STEP 6: Click ‘My Content’ and select ‘My Groups’. You will see that you have a range of options available for 

displaying search results e.g. in compact view, as a list, with enhanced filtering and sorted.  

STEP 7: Click on the Filter Button then expand ‘My Groups’ and select ‘CaBA Online Data Package’ 

from the list of available groups. You will now see a list of all the layers within in the new online CaBA data 

package which are available for CaBA partnerships to reuse within ArcGIS Online Maps. [NB: You should 

have been invited to join the CaBA Online Data Package Group prior to attending the course]. You can 

narrow your search down by typing key words into the Search Box. In this example we are going to search 

for layers in the CaBA data package related to ‘Flooding’. Click on a layer in the search results to bring up 

more information about that layer and its source. 

STEP 8: Try adding the ‘Risk of Flooding from Rivers & Sea’, and ‘Risk of Flooding from Surface Water (Basic)’ 

Datasets. Click on the layer you want and then select ‘Add to Map’. When you have selected all the layers 

you want click the Back Arrow at the top of the Add Layers pane.  

 

STEP 9: Following the same processes as above try adding some more layers from the CaBA data group. This 

time adding the ‘CaBA Catchment Partnerships’ and ‘WFD River Status 2019’ layer. You may want to change 

the search term e.g. from flooding to CaBA. 

STEP 10: Click on one of the rivers in the WFD River Status layer. You will see we have pre-configured the 

pop-up and there is a link to the EA’s Catchment Data Explorer. Many of the CaBA layers have pre-

configured pop-ups such as this. 

STEP 5 STEP 6 

STEP 7 

STEP 8 
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NOTE: If your layer does not appear on the map and is greyed out in the contents window you need to zoom 

in or out on your map until you reach the visible scale range that has been set for your layer. This is to 

optimise drawing speeds for detailed datasets. For example, try zooming in and out and you will see how 

the flood risk layers turn on and off. 

Filtering CaBA data layers to your catchment 

We have added CaBA Partnership IDs to many of the layers within the online CaBA Online Data Package. 

This enables you to filter the data to show only those data points which lie within your catchment boundary. 

STEP 11: We are going to filter the ‘CaBA Catchment Partnerships’ layer to show only the Tees Catchment 

Partnership area. To do this hover your mouse over the CaBA Catchment Partnerships layer name in the 

contents window and click on the filter symbol. 

 This will open the filter dialogue box below. Select CaBA Catchment is Tees. Hint: if you 

click the unique radio button you will get a list of all the CaBA Catchments to choose from. 

Then click ‘Apply filter and zoom to’. 

 

 

 

 

 

 

 

STEP 12: Now try filtering the ‘WFD River Status 2016’ layer using the same process to only show data from 

within the Tees Catchment. Remember to keep saving your map! 

Note: not all layers can be filtered to your CaBA Partnership e.g. ‘Risk of Flooding from Rivers and Sea’ and 

‘Risk of Flooding from Surface Water’ layers. This is the case where we have added data into the online data 

portal that has been published by another organisation e.g. Environment Agency or Natural England where 

the original publisher did not add CaBA IDs. 

 

You can also view the CaBA Online Data Package in full via the CaBA Open Data Portal  

 

https://data.catchmentbasedapproach.org/   

 

Many of the datasets allow you to download them in a variety of formats and have an API. This allows 

organisations who use a different GIS or mapping system to ArcGIS to access the data and use it within their 

systems, helpful to know if you want to share data with other members of your partnership.  

https://data.catchmentbasedapproach.org/
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Adding Web-Mapping Services (WMS) to a map 
A Web Mapping Service (WMS) is a standard protocol for serving (over the Internet) georeferenced map 

images which a server generates using data from a GIS database. If you just want to view the data WMS are 

a very quick and easy way to add data to your online map. However, as the data is served as an image, they 

typically have limited functionality for example you cannot customise the symbology, add pop-ups or filter 

data. Many government agencies have published WMS versions of their datasets which are available via the 

.gov.uk Defra Data Services Platform: https://environment.data.gov.uk/ 

STEP 13: Go to the Defra Data Services Platform via the link above and search for some data that you might 

want to add to your map. For example, the ‘Historic Flood Map’.  

STEP 14: Click on the layer to open a summary of the dataset. Scroll down towards the bottom of the page 

and click the button to copy the WMS link to your clipboard. 

STEP 15: Remember to check the licence for any layers you might want to add. Many are published under 

the Open Government licence, but some have conditions attached. 

 

 

 

 

 

 

 

 

 

 

 

STEP 16: Return to your AGOL Mapping workspace. Click ‘Add’ then ‘Add layer from Web’. This will open a 

dialogue box.  

STEP 17: Within the dropdown box select ‘A WMS OGC Web Service’ from the dropdown box. Paste your 

WMS link into the URL box and then click the ‘Get Layers’ button. Select the layers you want from within 

your WMS link and then click the ‘Add Layers’ button. Your layers will be added to the map. 

STEP 18: Remember to save your map. 

Note: As well as the publicly available datasets within the Defra Data Services Platform you can also 

register as a CaBA Co-Delivery Partner to access further datasets. Remember to check the licence for these 

as they may have special conditions such as Do Not Publish attached. 

https://environment.data.gov.uk/
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Adding your own data from Microsoft Excel 
You can also add your own survey data to the map from spreadsheet form. In this example we are going to 

add some stream flow data for the Tees Catchment in December 2015 which has been downloaded from 

the National River Flow Archive https://nrfa.ceh.ac.uk/ . 

Two important points to remember when adding data direct from spreadsheet form: 

1. Your data must contain coordinate data in Latitude and Longitude format. A helpful site for converting 

British National Grid to Lat/Long is http://gridreferencefinder.com/batchConvert/batchConvert.php  

2. Your data must be saved as a .csv (Comma delimited) file type 

 

STEP 19: Download the ‘Tees Dec 2015 Flow 

Data’ csv from the Rivers Trust AGOL Training 

Data group: https://arcg.is/1vGniq0. The 

spreadsheet contains flow data for 5 gauges in 

the Tees Catchment including station name, 

station URL within the National Flow Archive, 

lat/long coordinates, and the daily mean flow 

in m3/s throughout December 2015. 

STEP 20: Return to your AGOL map workspace. 

Click ‘Add’ then ‘Add layer from file’. In the 

dialogue window which opens browse to select 

your ‘Tees Dec 2015 Flow Data.csv’ file and 

click ‘Import Layer’. You can also drag and drop 

a csv file from your desktop onto your map. 

STEP 21: Your data will be added to the map 

and automatically open the Change Style 

window. In the Choose an attribute to show 

dropdown box select ‘Show location only’. This will use a single symbol for all points (flow gauges) within 

the dataset. Then click ‘Done’. Remember to save your map! 

You will learn more about changing symbology in the next section.    

https://nrfa.ceh.ac.uk/
http://gridreferencefinder.com/batchConvert/batchConvert.php
https://arcg.is/1vGniq0
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Changing the style and symbology  
STEP 22: Hover your mouse over the ‘Tees Dec 2015 Flow Data’ layer in the content 

window and select the Change Style symbol. This will open the Change Style dialogue 

window. 

STEP 23: In the Change Style dialogue window under ‘Choose an attribute to show’ make sure 

‘show location only’ is selected. Then under ‘Select a drawing style’ click the ‘OPTIONS’ button on the 

‘location (single symbol)’ box.  

STEP 24: In the next dialogue window click on the word ‘Symbols’. You can now choose some new 

symbology from a range of styles and alter the symbol size. 

You can also click the use an image link to add your own bespoke symbols to your map. To do this, images 

must be hosted on the internet and have a unique URL. 

Within the Change Style dialogue window you can also alter the transparency of your layer and the visible 

scale range. Once you are happy with your new style click ‘OK’ and then ‘DONE’.  

 

 

 

 

 

 

 

 

 

 

STEP 25: If you want to vary the symbology of your data by attribute, for example within the ‘Tees Dec 2015 

Flow Data’ layer to vary the symbology by Gauging Station name go back into Change style window and this 

time under ‘Choose an attribute to show’ select ‘Station’. Click the ‘OPTIONS’ button under ‘type (unique 

symbols)’. This will open the window below. You can either click on the symbols themselves to edit each 

individually or you can click the word symbols to make a change such as changing symbol size apply across 

all symbols. You can also move items up and down in the legend order and change the legend labels. 

STEP 24 

Change the transparency 
and visible scale range of 
your dataset here. 
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Advanced symbology 

You can use the Arcade scripting language available in AGOL to write your own custom expressions to 

create more bespoke symbology, pop-up and labelling options. For example, for the Tees Dec 2015 Flow 

Data we could use this to symbolise gauging stations by size based on their average mean daily flow 

throughout December even though this is not an attribute currently calculated within the existing dataset. 

The video demo below shows how Arcade can be used in this way. 

Support Video: Demonstration of basic symbology and labelling capability of Arcade in ArcGIS Online 

https://www.youtube.com/watch?v=OMF9Tr-y7YI  

Help: You can find out more about using Arcade from the ESRI help pages at 

https://developers.arcgis.com/arcade/  

 

Varying the transparency of layers 
It can be helpful to vary the transparency of certain layers so 

that you can view the basemap or underlying datasets more 

easily. We have already seen one way to do this within the 

Change Symbology function (Step 24) above. You can also do this 

more directly within the Table of Contents. 

STEP 26: Hover your mouse over the CaBA Catchment 

Partnership layer in the table of contents and click the three dots 

‘More Options’ symbol. Select transparency and then use the 

slider to vary the transparency of the layer until you are happy with it. 

Click each symbol to 

edit individually 

Click the label name 

against each symbol to 

change the name that 

appears in the legend 

Click the word symbols 

to make a change that 

applies to all symbols 

e.g. change size 

Click the 3 dots to 

drag items up and 

down within the 

https://www.youtube.com/watch?v=OMF9Tr-y7YI
https://developers.arcgis.com/arcade/
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Configuring Pop-Ups 
STEP 27: Hover your mouse over the ‘Tees Dec 2015 Flow Data’ layer and select the ‘More options’ 3 dot 

symbol “…”. Select ‘configure pop-up’ from the list. This will open the pop-up window below.   

STEP 28: Give your pop-up a title e.g. ‘Mean Daily Flow Data (m3/s)’. If you want your title to reflect 

attributes from one of the fields in your data you can select the relevant field by clicking on the small plus 

sign next to the title box, e.g. you might want to select {Station} to show the gauging station name.  

STEP 29: Under pop-up contents you can choose a display format. In 

this case we are going to choose ‘A list of all field attributes’. Click 

the blue ‘configure attributes’ link highlighted in the image to the 

right to select which attributes you want to show in your list.  

We are going to choose to show only the station name, latitude and 

longitude. You might also want to change the field aliases to 

something more meaningful for example change ‘station’ to ‘station 

name’. When you have selected all the fields you want to show click OK.  

 

 

 

 

 

 

 

 

 

 

 

STEP 30: You can also add images or graphs to your pop-ups. We are going to add a hydrograph for each 

station to our pop-up. To do this scroll down within the pop-up window and click on ‘Add’ under Pop-up 

Media and then select ‘line chart’. This will open the dialogue window below. 

STEP 31: Give your chart a title e.g. ‘December 2015 Hydrograph’ and a caption e.g. ‘Hover over the chart to 

see the ‘Mean Daily Flow (m3/s)’. Then select all the date fields being careful to ensure the latitude and 

longitude fields are not checked. Then click ‘OK’. 

Check the attributes 

you want to display 

in the pop-up 

Check/uncheck the box 

next to display to turn 

all attributes on or off 

Use arrows to move 

attributes up and 

down in the pop-up 

Check the attributes you 

want to be editable 

Click labels under field 

alias to change their name 
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STEP 32: Now click ‘OK’ in the main configure pop-up window to close the dialogue box and return to your 

map. Click on one of the gauging stations to view your new pop-up. Remember to keep saving your map! 

STEP 33: As well as a simple list of attributes you can configure your pop-up to show custom text. To do this 

re-open the configure pop-up window for the ‘Tees Dec 2015 Flow Data’ layer. Choose ‘A custom attribute 

display’ from the pop-up contents display dropdown. Then click the green ‘CONFIGURE’ button. This will 

open the dialogue window below. 

STEP 34: You can enter your own bespoke ‘static’ text which will appear in every pop-up within that dataset 

simply by typing the wording in the box. You can also include ‘dynamic’ text that will vary between points in 

the dataset according to the field attributes for that point. To add dynamic text, click the small plus sign to 

the right of the size box and select the field from which you want text to appear. In this case select {Station} 

to add the gauging station name. Use these two methods to enter the text as show in the image below. 
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STEP 35: You can also add dynamic hyperlinks links to your pop-up, provided the URLs are contained in the 

attribute table for your dataset. In this case we are going to add a hyperlink to the National Flow Archive 

page for each gauging station. Click the small plus sign and select {Station_URL}. This will appear in the text 

box. Now cut (Ctrl + X) the wording [Station_URL} from within the box. Highlight the word HERE with your 

cursor, click the hyperlink symbol (shown in the green circle below) and paste (Ctrl + V) the text 

[Station_URL} into the URL box. Click ‘Set’. Then click ‘OK’ and then ‘OK’ again to close the main configure 

pop-up window. Click on one of the gauging stations to view your new pop-up. 

Managing Labels 
STEP 36: Hover your mouse over the ‘Tees Dec 2015 Flow Data’ layer 

and select the ‘More options’ symbol “…”. Then select ‘create labels’ 

opening the dialogue window to the left. Ensure the label features 

box is checked. Select the attribute you want to label in this case 

station name, select the label size and colour. Adding a Halo around 

your label can often make it stand out more on a coloured 

background. Select the label alignment or position and the scale 

(visible range) over which you want it to appear. 

To remove labels at a future point return to the label dialogue 

window and uncheck label features. 

 

Advanced labelling: You can write your own bespoke labels using the Arcade scripting language by selecting 

Custom Expression in the text dropdown box. For more information about this see the demo video and help 

links in the symbology section. 
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Adding data from other publishers on ArcGIS Online 

There are many other people publishing data to AGOL which is publicly shared which you may want to look 

at or add to your maps. You can search the entire AGOL database for data. Doing this will typically return 

numerous datasets and you need to take care checking that the author of the data is trusted to ensure the 

data is reliable. 

STEP 37: In this example we are going to search for Site of Special Scientific Interest (SSSI) data. Go to ‘Add’ 

then ‘Search for Layers’, then select to search within ‘ArcGIS Online’ from the dropdown box and enter ‘Site 

of Special Scientific Interest’ in the Search Box. Now hit ‘Enter’ on your keyboard. 

 

As you will see the search returns numerous datasets that 

have been published by many different users. The results 

box tells you who has published the data and you can click 

on the dataset title to bring up more information about it. 

In this case we are looking for open data layers published 

by Natural England (OpenData_NE). It is always best to use 

authoritative datasets from organisations you know and 

trust in published maps and apps (less likely to disappear 

or be changed). 

 

 

 

For Information: Natural England have an excellent Open Data site which you can access at 

http://naturalengland-defra.opendata.arcgis.com/  

 

Adding data from the Living Atlas 
The Living Atlas of the World is an evolving curated collection of authoritative, ready-to-use global 

geographic information from Esri and other contributors and curators. We have submitted many of the 

CaBA Data Package layers to the Living Atlas. It includes imagery, basemaps, demographics and lifestyle, 

landscape, boundaries and places, transportation, earth observations, urban systems, oceans, and historical 

maps that can be combined with your own data to create maps, scenes, and apps and perform analysis. 

Many of the layers within the Living Atlas have been produced at global or regional scales and therefore do 

not contain the level of detail required for catchment analysis. However, it is still worth a look to see what is 

available in your area. 

Please also be aware that many of the layers within the Living Atlas are listed as subscriber or premium 

content!! 

http://naturalengland-defra.opendata.arcgis.com/
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Subscriber content requires an organizational subscription account to access. Subscriber content is 

provided as part of your organizational subscription and does not consume any credits. However, if you add 

subscriber content to a map which you then want to share more widely please be aware that your map or 

app will not automatically be accessible to people without an organisational account. Whilst these layers 

may be helpful for internal analysis, they are best avoided when creating online maps or apps which you 

want to share publicly.  

Premium content requires an organizational account to access and consumes credits. Access and credit 

information is listed on the item page description for each item so always check before you use.  

There are ways to add these types of data to your public maps and apps – see here for more info on using 

subscriber and premium content: 

https://blogs.esri.com/esri/arcgis/2015/07/17/using-subscriber-content-in-web-apps/ 

STEP 38: To browse and add data from the 

Living Atlas click the ‘Add Data’ button and 

then click ‘Browse Living Atlas Layers. This 

will open the browsing window.  

Use the Filter button to narrow down your 

search and check the within map area box to 

limit your search to layers that are available 

within your area of interest.  

Look through the Living Atlas layers and 

select some layers to add to your map. 

Find out more about the Living Atlas at 

https://livingatlas.arcgis.com 

 

 

Editing an existing Map [This next section is for people who already have a catchment 
StoryMap] 
 

We are going to add the Working with Natural Processes Opportunity Maps to each Story Map. If you don’t 

want to add these layers to your Story Map, follow along with someone who does. 

STEP 1: The first stage in adding new data to your catchment portal is to add new data layers to the correct 

map. Return to your AGOL Contents page and open the most relevant map for your catchment, where you 

would like to include NFM opportunities e.g. Catchment Issues Map. 

STEP 2: Once the map is open add the following layers to your ‘[NAME] Map’ from the CaBA Online Data 

Package Group: 

https://blogs.esri.com/esri/arcgis/2015/07/17/using-subscriber-content-in-web-apps/
https://livingatlas.arcgis.com/
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• WWNP Floodplain Reconnection Potential 

• WWNP Runoff attenuation features 1in30 AEP 

• WWNP Runoff attenuation features 1in100 AEP 

• Riparian Woodland Potential 

• WWNP Floodplain Woodland Potential 

• WWNP Wider Catchment Woodland Potential 

 

For a refresher on how to do this see Page 17 of this manual. These layers have all be published by the 

Environment Agency and do not include the CaBA Catchment ID so unfortunately, they cannot be filtered to 

your catchment. Turn all the newly added layers off, make sure the map is zoomed to your catchment 

location and then save your map. 

 

Updating data layers [This next section is for people who already have a catchment 
StoryMap] 
 

We are going to update the WFD Overall Status layer within your existing map from the previous 

classification to the 2019 classification. 

STEP 1: The first stage to updating data layers within your catchment portal is to find the correct map which 

stores the data for that app. Return to your AGOL Contents page and find the most relevant map for your 

catchment e.g. Catchment Characteristics Map. 

 

STEP 2: Once the map is open remove the existing WFD Overall 

status layer 2015 from your map. It may be called WFD Overall 

Status 2015 or WFD River Status 2015 or something similar. Hover 

over the layer name in the contents pane and click the 3 dots more 

options button and select remove. Click Yes, Remove layer to 

confirm deletion. 

STEP 3: Now we need to Add in the new data layer ‘WFD River 

Status 2019’ and filter it to your catchment. For a refresher on how 

to do this see pages 18 of this manual.  

 

STEP 4: Once added make sure the layer is unchecked, zoom the map to your catchment location and save 

the map.  
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Sharing a simple web-app 
We are now going to share your map. 

STEP 39: Turn off all the layers in your map except ‘Tees Dec 2015 Flow Data’, ‘CaBA Catchment Boundaries’, 

and ‘Risk of Flooding from Rivers and Sea’.  

STEP 40: Zoom your map in or out to the extent you would like people to see when they open your map and 

then click ‘Save’. 

STEP 41: Now click the ‘Share’ button. Check the ‘Everyone (public)’ box to share your map with everyone.  
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 PUBLISHING YOUR OWN DATA TO ARCGIS ONLINE 

In this session we show you how you can upload and publish your data from desktop GIS and files to AGOL. 

You will: 

• Learn about different types of online data and the pros and cons of each  

• Learn how to upload and publish datasets direct to AGOL 

• Learn how to publish large and complex datasets direct from ArcGIS Desktop 

Hosted Feature Services 
So far you have learnt how to use data which is already published on the internet to create a map and share 

this in a simple app.  You have also learnt how to add point data to a map from a .CSV file by uploading 

direct to an ArcGIS online map. You can also upload shapefiles direct to your map in the same way.  

However this method is not efficient for large datasets so there is a 

limit of 1,000 features to prevent your map loading too slowly. Also 

data uploaded directly in to the map this way cannot be re-used in 

other maps or shared with other users. 

To upload a file beyond the feature limit set by ArcGIS Online, you need to use feature services. Feature 

services are a more scalable way to publish features, and this method supports vector feature querying, 

visualization, and editing, as well as sharing beyond a single web map.  These are also called Hosted 

Feature Services, because ArcGIS Online takes care of hosting the layers and data which populates them, so 

you don’t need a web GIS server in order to share your data, just an AGOL organisational account. 

There are several ways to publish feature services, including direct upload to AGOL, and publication from 

ArcMap and ArcGIS Pro, ESRI’s desktop GIS software.  You should have access to ArcMap and ArcGIS Pro if 

you have an AGOL organisational account, but if not then contact your organisation’s GIS administrator for a 

license. 

Uploading and Publishing Feature Services direct in AGOL (Demonstration) 
The easiest way to publish feature services in AGOL is to upload zip file containing your shapefile or file 

geodatabase. You can use this method for files up to 1Gb in size. For larger files, for layers which you need 

to update frequently, or where you need highly accurate spatial referencing or if you wish to replicate 

existing desktop symbology, use the ArcMap method (see below). 

STEP 1 Zip up the shapefile or geodatabase which you wish to 

publish.  

STEP 2 In AGOL go to Contents > My Content and click Add Item > 

From my computer 

STEP 3 Select your zip file and select the type of contents (shapefile 

or File Geodatabase) from the drop-down 

STEP 4 Check the box to publish the file as a hosted layer. 
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STEP 5 Enter a title and tags, then click Add Item 

Uploading and publishing your feature service may take some time, depending on the size and complexity 

of your data. Once finished, you can find your feature service in My Content.  

 

Uploading and Publishing Feature Services from ArcMap (Demonstration) 
This method is recommended for anyone familiar with ArcMap and already using it to manage GIS data 

locally.  You can create, edit, attribute and symbolise your GIS data in ArcMap and then publish to AGOL, 

and this will bring most of the symbology and spatial reference system across to AGOL.  If you don’t have 

access to ArcMap or you only use other desktop GIS packages like MapInfo or QGIS then you can still 

publish feature services on AGOL by uploading a shapefile directly as per the previous method, though you 

will need to create the symbology from scratch in AGOL as there isn’t currently a reliable way to import 

symbology from other GIS packages. 

STEP 1: Open ArcMap and add your chosen dataset and symbolise it as you would like it to appear in AGOL 

– you may wish to test it against various basemaps to check appearance and set transparency if required. 

(N.B. Only load and publish one dataset at a time from ArcMap and don’t include a basemap, otherwise all 

the layers will be bundled in to one service name and it will be difficult to manage them individually in 

AGOL maps.) 

STEP 2  In ArcMap click File > Sign in to connect to your AGOL account and sign in with your organisational 

username and password.  

STEP 3 Now click File > Share As and choose Service, then Publish a service and click Next. 

STEP 4 Choose My Hosted Services (<Your Organisation 

Name>) from the drop-down and then enter a brief service 

name in the text box (no spaces) and click Continue.  

STEP 5 In the Service Editor dialog, click Capabilities and 

check Feature Access and uncheck Tiled Mapping.  
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STEP 6 Click Item Description and enter a summary and tags and as much description information as you 

can (this will help others to find and use your data). 

 

STEP 7:  Click Analyse to check your data for any issues before you publish.  You can disregard warnings and 

messages, but any red Error symbols will need to be fixed before you can publish.  Double-clicking the error 

in the table will often fix the problem or provide more information which you can use to request technical 

support from ESRI (included with a non-profit license). 

 

STEP 8 Once any errors are resolved, click Publish and let the tool run.  N.B. this can take some time, 

depending on the detail in your data, and your internet connection speed. Eventually you should see a 

confirmation message that the service has been published successfully.   
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You can now find your service on AGOL my looking in My Contents (usually in your top-level folder) and can 

use and share this with others. 

 

Limitations of Feature Service symbology  
There are some aspects of your ArcMap symbology which 

won’t be carried across to AGOL., including labels.  

Labelling in AGOL is quite basic– currently you can’t wrap 

labels on multiple lines or follow features (for example 

placing river names along the curve of the river). Polygon 

hatching is also not possible in AGOL, and although you 

can bring some hatch symbols across from ArcMap, you 

can’t then edit these in AGOL.  Also, there are restricted 

point symbols on AGOL so it is best to test uploading your symbols to see if they will translate before you 

spend a lot of time setting up complex symbology in ArcMap.  It is worth remembering that AGOL is good 

for sharing, but it does this by simplifying the display of maps and data, so if you need to produce 

cartographically advanced maps then you still need to use desktop GIS. 

Uploading and Publishing Feature Services from ArcGIS Pro (Demonstration) 
This method is recommended for anyone new to ArcGIS, who isn’t already familiar with ArcMap, because 

ArcGIS Pro will soon replace ArcMap. Also, ArcGIS Pro works more seamlessly with ArcGIS Online, though it 

does still have some limitations compared to ArcMap. You get both packages with your license, so you can 

use both on the same PC. 

STEP 1: Open ArcGIS Pro and add your chosen dataset and symbolise it as you would like it to appear in 

AGOL. You can create and share single layers, or whole maps from Pro, 

and you can open existing web maps into Pro and edit the online data 

(provided you have set the permissions to allow this). What you still can’t 

do is edit an AGOL web map in Pro and publish the changes to that same 

map. You would have to publish the changes to a new AGOL web map. 

STEP 2: Right click 

the layer you wish 

to publish and 

select Sharing > 

Share As Web Layer.  

STEP 3:  Type in a layer name, summary and tags for your layer.  Check 

layer type is Feature and select which folder on your AGOL account you 

wish to publish the feature service to. Set the sharing options and then 

click Analyze to check the layer before publishing.  
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STEP 4:  Ignore any warnings with a yellow triangle, but you must fix 

any errors with a red circle and cross.   

STEP 5:  Once you have dealt with any errors, click Publish to share 

your layer as an ArcGIS Online Feature Service. 

 
 
 
 
 

Uploading and Publishing Tiled Map Services  
Sometimes your datasets will be so complex or detailed 

that they may just slow your maps and apps down too 

much if you include them as feature layers, or you may 

find that licensing conditions require you to only publish 

a restricted view of the data. In this case you could 

choose to publish your datasets as a view-only raster (image) layers.  The end user can’t manipulate these to 

change symbology or analyse spatial relationships, but they are a great way to speed up map display and 

enhance the visual content of your maps and apps.  It is also possible to ‘buddy up’ feature and tile map 

services, using feature layers for attributes and tile layers for display, in order to gain the best of both.  

There are lots of ways to publish tiles, but we will demonstrate the one that has worked best for us. You can 

find more guidance about other methods here:  

http://doc.arcgis.com/en/arcgis-online/share-maps/publish-tiles.htm  

 

Build a tile package in ArcGIS Pro, upload and publish to your ArcGIS Online 
organization (Demonstration) 
We recommend this method because the work of creating the tiles is done in desktop software, so it doesn’t 

use any service credits. We recommend using ArcGIS Pro rather than ArcMap to do this, because Pro works 

more seamlessly with AGOL, and we have encountered problems with tiled map services created in ArcMap.  

ArcGIS Pro is one of the components of ArcGIS Desktop which you have as part of the non-profit license 

alongside ArcMap, and in the next few years it is expected to replace ArcMap as the primary desktop 

package, so it is worth starting to use it.  Please refer to ESRI support if you need help setting up your ArcGIS 

Pro installation: http://pro.arcgis.com/en/pro-app/get-started/get-started.htm  

 

http://doc.arcgis.com/en/arcgis-online/share-maps/publish-tiles.htm
http://pro.arcgis.com/en/pro-app/get-started/get-started.htm
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STEP 1: Open ArcGIS Pro and create a new project, then add your 

chosen dataset to a new map and symbolise it as you would like it to 

appear in AGOL – you may wish to test it against various basemaps to 

check appearance and set transparency if required. 

 

STEP 2: Remove the basemap by right-clicking and selecting remove.  

(You don’t want to include the basemap when you generate the tile 

map package, otherwise it’ll include the entire global coverage of 

that basemap!)  

 

STEP 3: Open the Create Map Tile Package 

geoprocessing tool. (Click Tools on the Analysis ribbon to 

search for the tool.)  The Level of Detail (1-20) 

determines how detailed your tiles will be – Level 15 will 

show the data down to about 1:18,000 scale.  Remember 

the more detail you include, the greater the storage 

requirement and the ongoing cost.  Click Run to 

generate the tile package. 

 

STEP 4: When your tile package has finished generating, 

sign into ArcGIS Online using an organizational account 

that has privileges to create content and publish hosted 

tile layers and click Content > My Content. 

 

STEP 5: Add the tile package by clicking Add Item > From my computer. 

Check the box to Publish this file as a hosted layer. Type a title and add 

tags and click Add Item.  Publishing the tiles can take quite some time, 

depending on the size of the area and the level of detail, but once 

finished you can view the data in a map.  
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 CREATING AND EDITING A STORYMAP 

 

In this session you will: 

• Learn how to create and a StoryMap using Esri’s new template. 

• Add text, photos, video and audio to your StoryMap. 

• Embed your map content and enable dynamic actions. 

• Customise the appearance of the StoryMap and add your organisation’s logo. 

 

Creating a Story Map using Esri’s new template 
 

When creating your StoryMap, it is important to note that the new templates have an autosave feature. This 

removes the need to constantly save your work, however be warned that any changes you make will be 

saved and that there is no ‘Undo’ function as yet. Therefore, consider backing up any key sections of text in 

a word document or other format in case of an error. Although you cannot undo actions, there is the option 

to revert to the last published version of your StoryMap. However, this option will only be available if you 

have published your StoryMap at regular intervals and are willing to lose all changes since the last time the 

StoryMap was published.  

 

STEP 1: Sign in to your organisational account and navigate to ‘My content’. 

STEP 2: Click the ‘Create’ tab. A range of options will appear. Choose ‘StoryMaps’. 
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STEP 3: Add a title and cover image or video to your StoryMap. Top Tip: Make this image as striking and 

engaging as possible to capture the reader’s attention. To add an attribution for the image, click on the cog 

symbol. This is positioned at the top centre of the image. The attribution will then appear on the image if 

the user clicks the information symbol in the top left-hand side of the image.   

 

STEP 4: Click on the ‘Design’ tab at the top of the page to change the cover layout, colour theme and to 

include in-story navigation and a credits section at the end of the StoryMap. You also have a limited choice 

of fonts and can upload a logo and link to your organisation homepage. In addition, you can create a 

custom theme which will be applied to your StoryMap by clicking ‘Browse themes’.  

 

 

 

STEP 5: Add StoryMap elements. 

There are a wide range of elements which can be inserted into your StoryMap and reordered as required. A 

description of each element is covered in detail in the following section of the guide.  

 

Headings and text 

Scroll down and click the plus symbol to add text. An option will then appear so you can choose to insert 

header or body text. If you have enabled in-story navigation, any header text will automatically be added to 
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the navigation bar running along the top of the screen. This will allow users to click between headers while 

scrolling through your StoryMap.  

 

If you would like to use your organisation’s branding in the StoryMap, you can customise the text colour. 

You can do this either by creating a custom theme from the Design configuration tab (See STEP 4), or if you 

need each text block to differ you can use the following method. By highlighting some text, the following 

options will appear (See below). Choose from the pre-set colour options or insert the Hex code of your 

organisation’s brand into the custom colour field. Alternatively, search for ‘colour picker’ in google. You can 

move the cursor to find the exact colour you want, copy the Hex colour code and then paste it into the 

custom colour field. 

  

Standalone images, video, audio and embedded content 

Click the plus symbol again to add various other elements including images, audio files, and videos. All 

these elements can be uploaded directly from your computer, or you can link to media already published 

on the internet. You can also embed additional content, such as social media posts and data dashboards. 

Where images require an attribution, this can be added by including it in the caption below the image. 

Standalone maps 

Click on the plus symbol to add a map from your content. The map will 

then appear in a new window with the option to zoom into a particular 

area or to use your bookmarks. You can also choose which layers to 

visualise by clicking and unclicking the eye symbol next to each layer in 

the contents view on the left-hand side of the screen.  

 A button in the bottom left-hand corner called ‘Edit map in ArcGIS’ will 

open up your map in a new window and allow you to edit symbology and 

other properties. Alternatively, you can edit your map by opening it 

directly from ‘My Contents’. Note: Remember you will have to manually save any changes in your map. 

Autosave only applies to the StoryMap.  

Once the map has been inserted into your StoryMap, you can choose from some size display options as 

shown in the screenshot below. 
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Swipe 

The swipe element is fairly self-explanatory. You can choose this element by clicking on the plus symbol in 

the main body of the StoryMap. You can then select a map or image to use on each side of the swipe. This 

element be useful for comparing mapped data points between years or for incorporating fixed point 

photography images.  

Slideshow 

The slideshow option allows you to incorporate a range of media which users can flip through laterally, by 

clicking the arrow on the right-hand side of the screen. You can include a mixture of images, maps, video 

and embedded content with optional text which floats in a text box. There is the option to move this text 

box to various positions in order to avoid obscuring key elements of the media. Unlike the Sidecar element 

(See below) it is not possible to include additional media within the text box.  

You can add additional slides by clicking on the add symbol in the bottom right of the screen and reorder 

slides by dragging them.  

Where images require attribution, this can be added by clicking on the cog symbol in the same way as 

adding the attribution for the StoryMap cover image.  
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Side car 

This element can be used when you need to incorporate narrative alongside your media. In many ways it is 

similar to the Slide Show element, but users scroll vertically, rather than clicking to move laterally. As with 

the sideshow element, you can include a range of media including images, video, embedded content and 

maps for the main focus of the screen.  

The sidecar element includes two layout options: narrative in a docked panel and in a floating panel. The 

docked panel will work better if you have a large amount of explanation associated with your main media 

content. The main media in the Slidecar element stays fixed as users scroll down through the narrative 

content in the left-hand side panel. This allows you to include longer explanations of your content than the 

Slideshow format would allow. Using the Sidecar format also means that you can include ‘Buttons’ in the 

narrative panel so you can highlight any links out to external content. You can also include images, maps 

and videos within the panel itself.  

One key advantage of the Sidecar element is that you can include ‘Map actions’. This element can be added 

by the standard method of clicking the plus symbol in the narrative panel. You will first input a description 

of what will change when the user clicks the button, then if you click the pencil symbol, you can specify 

which layers you want to display when the user clicks that button.  

Additional slides can be added by clicking the plus symbol in the bottom right of the screen and the layout 

can be changed from the docked panel to floating or vice versa by clicking on the cog symbol in the bottom 

left of the screen and choosing ‘Change layout’.  

Where images require attribution, this can be added by clicking on the cog symbol in the same way as 

adding the attribution for the StoryMap cover image.  
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Guided tour 

This element allows you to place points at various locations on a map. As the user scrolls down the page 

they will be taken through the points in order and can view the content associated with each point. This is a 

useful element to use when you want to demonstrate the location of a range of projects throughout your 

catchment. 

There are two layout options: map-focussed and media-focussed. You can also choose a ‘custom level’ 

zoom in the editing section of each point if you need a higher level of detail at a particular point. The 

default basemap and location marker colour can be changed by clicking on the cog symbol in the top right 

‘Map options’.  
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Express maps 

Express maps are maps that can be created directly from within a StoryMap. This can be helpful when you 

would like to include a basic locator symbol for a particular project or to add some simple annotation.  

You can add an Express Map by clicking on the plus symbol and choosing ‘Map’ from the media options. You 

can come to a page with the choice of your existing maps, or you can select ‘New Express Map’. You can 

then navigate to your required location and use the options at the top of the screen to add locations, 

annotations, polygons or lines. The base map and other map settings can be changed by clicking on the cog 

symbol on the panel of the left of the screen. 

 

 

 

STEP 6: Add any required credits to the end of your StoryMap. Remember that any attributions for photos 

should be added to the images themselves. This can be done by clicking on the cog symbol for the 

immersible elements or by adding a caption underneath any standalone images. 

STEP 7: Preview your StoryMap to see how it will look to external users. The ‘Preview’ function found in the 

top ribbon allows you to see how your content will appear in the various formats (e.g. desktop, tablet, 

mobile).  
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STEP 8: Once you are happy with how your StoryMap appears, you can publish it. You can then choose to 

limit the sharing to your organisation only, or you can make the StoryMap public.  

STEP 9: If appropriate, include the new StoryMap in a collection of related StoryMaps.  

 

Further help and support 
Esri have produced a comprehensive video tutorial on creating StoryMaps with the new template which can 

be accessed HERE. They have also created a tutorial showing you how to create a collection from a number 

of related StoryMaps: HERE. 

The Anatomy of a StoryMap – Cheatsheet: https://arcg.is/15iaCq 

Further resources from ESRI: https://www.esri.com/en-us/arcgis/products/arcgis-storymaps/resources 

 

Example StoryMaps from CaBA using the new template: 

• Policy & Legislation: Wholescape Approach to Marine Management: https://arcg.is/01q1q1 

• Virtual Field Investigation: https://arcg.is/0rK4fq 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.youtube.com/watch?v=t_oFnIIJA-A
https://storymaps.arcgis.com/stories/c75fd3c46d9e4bc3a8bfbe1504dee2d3
https://arcg.is/15iaCq
https://arcg.is/01q1q1
https://arcg.is/0rK4fq
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 CREATING AND EDITING A DATA DASHBOARD 

 

ArcGIS Dashboards allow you to present your data using a wide range of visualisation formats. You can use 

a combination of interactive maps, graphs and tables which can also be easily embedded into StoryMaps in 

order to give them greater context. 

In this session you will: 

• Learn how to create and edit a basic dashboard.  

• Configure the dashboard to allow users to interact with and filter the data. 

• Customise the dashboard to reflect your organisation’s brand. 

• The creation of more complex dashboards will be covered in a dedicated guidance document.  

 

 

 

STEP 1: Sign in to your account and navigate to ‘My Content’. Click on the create button and select 

‘Dashboards’. You will be prompted to input a title, tags and summary for your dashboard. You can also 

select which folder to save your Dashboard in.  
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STEP 2: An empty dashboard will then appear in your browser. You can add individual dashboard elements 

by clicking on the plus symbol in the top right-hand side of the page.  
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STEP 3: Add a header for your dashboard. You can specify the header size, edit the title and subtitle and 

choose the colour for your font and background. You can choose from a selection of colours or add in a 

specific Hex colour code. You can also add a 

logo image URL and include a link to your 

organisation. Click ‘Done’.  

Step 4: If you need to go back and edit any of 

these settings, you can hover over the low 

rectangle shape in the top left-hand side of the 

header text box and some options will appear. 

Click the ‘Configure’ cog symbol.  

STEP 5: Add a map to your dashboard by clicking again on the plus symbol. You will be able to choose from 

any of the maps that you have created or have been shared with you. The next window will allow you to 

configure which elements will appear on the map (legend, default extent and bookmarks, scale bar, etc.). 

You can also specify text colour and add a description. Click done. Click on the Save symbol to save your 

Dashboard. Dashboards do not have an autosave option, so it is important to keep saving the Dashboard 

after every change you make.  

We’re going to add an existing map showing the locations of sample sites for TraC fisheries data in the Wyre 

catchment. This dataset can be found in the RT Training AGOL group: https://arcg.is/1vGniq0. The dataset 

contains survey coordinates, survey site names and dates, fish species and counts. We’re going to use the 

dashboard to display this data in a more accessible format than the original Excel spreadsheet.  

 

STEP 6: Add a serial chart to give your users greater insight into the data. Click on the plus symbol and 

choose ‘Serial chart’. A new window will open which will allow you to select from the layers in your map. 

You can either select a layer from the map that is already in your Dashboard or click ‘Select layers’ which 

will allow you to select any feature in your contents, or any feature which has been shared with you. For this 

example we’re going to use the same TraC fisheries data that we’ve already added to our map.  

Step 7: Ensure that ‘Categories from’ is set to ‘Grouped values’, then choose your category field from your 

data. In this example, we are going to create a graph of the fish count of each species, so choose ‘Species 

name’ in the category field. Leave ‘Parse dates’ and ‘Split fields’ blank and change the statistic to ‘Sum’. 

There are a range of statistics that you can choose here including standard deviation, count and average. 

 

https://arcg.is/1vGniq0
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The field for the statistic is the number that you would like to be summed for each fish species, in this case it 

is called ‘Fish Count’. Next, click ‘Sort by’, choose ‘Statistic’, then ‘Descending’ and choose the maximum 

number of species that you would like to see displayed on the graph. In this example, we have chosen to 

display the 8 most frequently caught species.  You can leave the remaining fields as their defaults.  

Step 8: The menu setting on the left-hand side of the screen, will also you to further customise your graph. 

Under ‘Chart’, you can choose the orientation of your bars and change the text colour. The colour of the 

bars can be changed under ‘Series’ and a chart title added in ‘General’. These instructions allow you to 

create a very basic graph, however, you can further modify the settings of your graph using this menu as 

much as necessary. When you are finished, click done to return to the Dashboard, move the graph to your 

preferred position on the Dashboard and then click Save. The graph can be moved by hovering over the top 

left hand corner. The ‘Drag item’ icon will then appear. 

 

  

STEP 9: Add a pie chart. Again, choose which data you would like to display. For this example, we’re going to 

use the TraC fisheries data from the Wyre again and display the survey method. In the configuration options, 

first ensure that ‘Grouped values’ is selected. Then choose ‘Survey method’ in the Category field and set 

Statistic to ‘Count’. This will create a pie chart showing what percentage of the count is attributed to each 

survey method. Next, click ‘Sort’ and use the drop-down menu to select statistic and change the ‘Sort by’ 

option to ‘Descending’. This will ensure that your pie chart starts with the most common survey method 

down to the least common.  

Step 10: Click through the additional configure options on the left to further customise your pie chart e.g. an 

inner circle can be added in ‘Chart’ by increasing the Inner Radius %, pie chart colour can be changed in 

‘Slices’ and you can add a title under ‘General’ and clicking on the edit icon next to ‘Title’. Once you are 

happy with the look of the pie chart, click ‘Done’, move it to your preferred position on your Dashboard and 

click Save. 
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STEP 11: Adding a selector allows your users to 

filter the data themselves and interact more fully 

with the information. You can do this by adding a 

Side panel via the plus symbol again. Configure 

the basics of the panel (title, text colour, etc.).  

Step 12: Hover over the flattened rectangle 

symbol on your side panel and select the second 

icon ‘Add category selector’. When the selector 

options window opens, choose categories from 

‘Grouped Values. A new window will open which 

will allow you to select from the layers in your 

map. You can either select a layer from the map 

that is already in your Dashboard or click ‘Select 

Layer which will allow you to select any layer in 

your contents, or any layer which has been shared 

with you. 

Step 13: In the Category field, click the drop-down list to choose the attribute that you would like your users 

to be able to interrogate. In this example, we’re going to create a Dashboard which allows users to filter the 

data by survey year. However, you could equally create a dashboard where the users can filter by fish 

species or sample location. Check that the maximum number of categories is greater than the number you 

have in your data (this is set to 50 as a default so you shouldn’t have to worry about this) and check that the 

‘Sort by’ field is the same as your category, in this case ‘Survey year’. You can choose to list your options in 

ascending or descending order. Next, input a label for your category selector and choose whether you 

would like your users to be able to select only single or multiple years. Leave the operator set as ‘Equal’ and 

choose your preferred display type (drop-down list/button bar/radio buttons). You will also have to check 

that the ‘Display type threshold’ is greater than your number of categories, otherwise the Display type will 

default to a drop-down list. If you want your users to be able to view the unfiltered dataset, you can next 

enable the ‘None option’ and choose a suitable name. In this example, this option has been labelled as ‘All 

years’. You can specify whether this option appears at the beginning of end of your list and whether the first 

or last value should be the default. It is important to make sure that the default is set to the unfiltered 

dataset (All years in this example).  
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Step 14: The next stage is to add some actions which will 

filter your graph and pie chart based on your Selector. For 

example, if a user clicks on the data for 2018, the fish species 

graph and survey method pie chart will display data for that 

year only. To do this, click on Actions on the left-hand side of 

the screen, click ‘Add target’ and select your graph from the 

drop-down list. Click ‘Add target’ again to also select your pie 

chart. You can add additional filters into your side panel if 

necessary. For example, you could add in a filter so users can select the data for specific fish species, or site 

location.  

Step 15: Click done and save your Dashboard. Your completed Dashboard should look something like the 

image below.  
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Step 16: Additional Dashboard elements can be added as necessary such as Gauges, Indicators and Lists. 

These features will be covered in a more detailed guidance document on Dashboards.  

Step 17: Customise your Dashboard settings clicking on the cog symbol next to the save button. Here you 

can set the theme of your Dashboard (light/dark) and set colours for a range of elements.  

 

Further help and resources 
 

Operations Dashboard for ArcGIS: An Introduction (Esri): https://www.youtube.com/watch?v=zrxYWzSvJ6E 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.youtube.com/watch?v=zrxYWzSvJ6E
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 ADDITIONAL CONFIGURABLE APPS 

 

Web AppBuilder: Custom web-app creation (Advanced) 
Web App Builder is a powerful tool that allows you to create custom web-apps choosing the layout and 

widgets which suit your needs. We have used this tool to develop the ‘Create your Own Evidence Map’ 

applications within several CaBA catchment portals including the Dove, Irwell and Cumbria Strategic Flood 

Partnership portals. You do not need to use any code to build your app instead the builder guides you 

through selecting a layout and theme, adding widgets and branding the app.  You can add widgets that 

allow the user to: 

view the legend turn other layers on/off change the basemap zoom to bookmarked locations, swipe layers, 

annotate their map, share the map, view the attribute table, filter layers add more data. 

Widgets can allow users to add 

new data from the CaBA data 

package, or a local evidence 

pack, or drag and drop a CSV file 

to map new points. You can use 

your app as a standalone product 

or embed it within one of the 

existing Story Map templates. 

You can find out more about 

using Web App Builder, including 

help pages and short video 

tutorials at 

https://doc.arcgis.com/en/web-appbuilder/  

 

STEP 1: Navigate to youor Content page and click the ‘Create’ button, choose ‘Configurable Apps’, then 

select ‘Basic Viewer’ from the app options.  

STEP 2: Then click the blue ‘Create WebApp’ button.  

STEP 3: Give your App a title such as ‘Flooding in the Tees Catchment’, some key word tags such as 

‘Flooding’ and ‘CaBA’ and save within the AGOL Training folder. Then click ‘Done’. It will take a few 

moments to generate your app and open to Configure App window. 

STEP 4: Select which map you would like to appear within your App. 

STEP 5: Within the general tab of the configure web-app window give your web-app a title such as ‘Flooding 

in the Tees Catchment’ and enter a short description about the app in the details box such as: 

 ‘This is a map showing data and evidence about flood risk within the Tees Catchment.’ 

https://doc.arcgis.com/en/web-appbuilder/
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STEP 5: Under the Options Tab select the tools or widgets you would like to appear in the app tool bar e.g. 

legend, basemap gallery, measure tool etc.... In this example select them all. Click ‘Save’ and the ‘Launch’ to 

view your final published web-app.   
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 SURVEY 123 & ArcGIS COLLECTOR 

 

Which to use? 
Survey 123 and ArcGIS Collector are both data collection applications. The main difference is that Collector 

is Map-focussed, whereas Survey 123 is form-focused. Both applications allow you to collect geographic 

data, however if location is just one of a number of pieces of information you plan to collect then Survey 

123 would be the more appropriate application to use. However, if the main purpose of collecting the data 

is the location and other information is secondary, then use Collector. 

Both applications work on computers, phones and tablets and data can be collected while both online and 

offline. These features make these applications extremely useful for collecting data in the field. Data can be 

inputted to Survey 123 by anyone who has been given the survey link, while Collector can only be used by 

someone with an Arc GIS Organisational licence.  

Survey 123 
Survey 123 is a form-focussed application which allows you to create forms to collect field data. The survey 

can then be shared with your users who can populate the form via computer, tablet or phone.  

Surveys can be created using two methods: 

1) Survey 123 website:  

• Web-based, no downloading of programmes required 

• Intuitive 

• Allows for basic survey logic 

• Good for creating basic surveys 

2) Survey 123 Connect 

• Desktop application 

• Spreadsheet based 

• Best for more complex surveys 

• Can integrate more complex survey logic and a wider range of question types 

 

In this session you will: 

• Learn how to create, edit and analyse a basic survey using the Survey 123 website. 

• The creation of more complex surveys including the use of Survey 123 Connect is not covered in this 

guide at present. There are however there are some very useful Esri resources for Survey 123 

Connect online (See further support). 
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STEP 1: Sign in to Survey 123 (https://survey123.arcgis.com/surveys) The sign in details should be the same 

as your AGOL sign in name and password.  

STEP 2: Click ‘Create a New Survey’. You will be prompted to choose between using the web designer and 

using Survey 123 Connect. We are going to create a simple survey, so choose the web designer option and 

fill in the title, tags and survey summary. 

 

 

STEP 3: We are going to create a basic survey to collect data from river litter picks There are a wide range of 

question types which you can choose from the right-hand side of the screen. We are firstly going to add a 

question to determine the date and time of the survey. Once you have added the question type, you will be 

able to edit the question name, specify default values and make the question mandatory/not. 

 

 

https://survey123.arcgis.com/surveys
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STEP 3: Add a drop-down question to indicate which staff member is leading the litter pick. All possible staff 

names can be added to the drop-down options.  

STEP 4: Next, add a map so the user can specify where they are carrying out their litter pick. Remember to 

then save your survey to prevent losing any work.  

 

STEP 5: Add a multiple-choice question and include the various types of typical rubbish which is found in a 

river. Add ‘Allow other’ if required.  

STEP 5: Add a number question to allow the staff member to estimate the weight of rubbish removed from 

the river.  
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STEP 6: You can also include basic skip logic into your survey, however at present this is only available for 

the following question types: Single Choice, Single Choice Grid, Dropdown, Likert, and Rating. This feature 

allows you to bypass or ask specific questions based on the users answer to an initial question. We will 

include this in your survey so you can see how it works. 

Firstly, add your initial question e.g. Please select the event type (community/corporate/school). Then add 

the next set of questions you would like your user to answer, based on their answer to the first question. 

Next, click on the three-pronged arrow symbol in the bottom right of the question box. This will allow you 

to set rules about which secondary question will be asked depending on the answer selected in the initial 

question. For example, if your user selects ‘Corporate volunteer’ as the event type, then the next question 

they will see is ‘Add the number of corporate volunteers present’. They will not see the questions about 

numbers of community volunteers or school children.  

If you require more complex survey logic in your survey then you will have to download Survey 123 

Connect. Links to support on using Survey 123 Connect can be found on page 57 (Further help and support).   

 

 

 

STEP 7: Add an image question to encourage to user to upload a photo of the litter pick. 

STEP 8: To change the order of any of the questions, simply drag and drop them into your preferred order.  

STEP  9: Save your survey. 
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STEP 10: On the appearance tab on the right-hand side of your screen, you can 

alter the heading, description and footer of your survey. You can also change the 

background colour by altering the theme or importing an existing theme. If you 

click on ‘Edit theme’ you can access a much wider range of settings. In these 

settings you can specify your organisation brand colours and choose to upload a 

background image for your survey.   

STEP 11: In the settings tab, you can choose whether or not your users will see a 

message saying that their data has been submitted. You have the option to turn off 

this message or edit it as necessary.  

STEP 12: Next, save your survey and make sure that you are happy with the 

questions and appearance.  

STEP 13: Click ‘Publish’. 

STEP 14: On the ribbon across the top of the page go to ‘Collaboration’. In these settings you can choose 

whether the survey will be opened as default in either the user’s browser or field app (Instructions about 

using the field app are in the next section). You can also choose who can submit responses to your survey. 

For example, you can limit it to members of your own organisations, to members of a specific AGOL group 

or to everyone (public). In addition, you can specify whether submitters will be able to amend or delete 

their previous responses and choose to open or close the survey. Once you are happy with the collaboration 

settings you have chosen, click save.  

STEP 15: Click on the Share button to get the survey links which you can share with your users.  

  

 

 

 

 

 

 

 

STEP 16: Once you have responses, you will be able to view and analyse them by clicking on those tabs in 

the ribbon along the top of the page. 
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Survey 123 Field App 

 

If you want to record assets out in the field and work offline, you will need to download the Survey 123 app 

to desktop or mobile device. To use the Survey123 app you need to do the following steps whilst you are 

connected to the internet: 

STEP 1: Download the Survey123 field app for desktop or mobile:  

STEP 2:. When the app first opens it will prompt you to login. If you have an ArcGIS Online account please 

login as this will allow you more edit control over your data in due course. If you don't have an ArcGIS 

Online account please ignore this prompt and go to step 3. 

STEP 3: Open your survey link to load the current survey form in to the Survey123 field app. 

 

Further help and support 

 

Esri have produced the following Survey 123 training course which you may find helpful: 

• Get Started with ArcGIS Survey123: 

https://www.esri.com/training/catalog/5890f7fc853ba420140b77a4/get-started-with-arcgis-

survey123/  

Esri have also created a video playlist focussing on Survey 123. Many of the videos on the playlist 

demonstrate the use of the desktop app, Survey 123 Connect. The playlist can be accessed HERE.   

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.esri.com/training/catalog/5890f7fc853ba420140b77a4/get-started-with-arcgis-survey123/
https://www.esri.com/training/catalog/5890f7fc853ba420140b77a4/get-started-with-arcgis-survey123/
http://www.esri.com/videos/watch?videoid=jfaSlJ6BYr4&channelid=UCgGDPs8cte-VLJbgpaK4GPw&title=Survey123%20for%20ArcGIS%20Product%20Overview
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ArcGIS Collector 
In this session you will: 

• Learn how to create and edit a basic feature for use in ArcGIS Collector to survey invasive plant 

species along a riverbank. 

 

STEP 1: Navigate to your Content, click on ‘Create’ then choose ‘Feature Layer’.  

STEP 2: Next, select a feature layer template. There are a wide range of templates organised into different 

industries. It is worth having a look at the range of templates available, but for now we’re going to choose 

the ‘Polygons’ template from the ‘Build a Layer’ group.  

STEP 3: A box will appear titled ‘Create a feature layer’, the polygon layer should be checked. Click here to 

rename this polygon layer ‘Invasive plant species’. Click Next.  

STEP 4: Choose the map extent for your feature layer then in the following window specify the name, tags, 

summary and folder for your feature layer. Click Done. It will take a minute or so to create your feature.  

STEP 5: On the feature overview page, click to the Data tab to add fields to your feature.  

 

STEP 6: Add a field for invasive species name. The field name cannot have any spaces or special characters, 

but you can also put in a more user friendly description under ‘Display name’. Enter the field type. The 

options are Date, Double, Integer and String. As we want this field as a text input, choose String here and 

leave the remaining settings as their default values. Click ‘Add new field’.  

 

STEP 7: Click on your new field in the field list, then choose ‘Create list’. This will allow you to input a set list 

of invasive species for users to choose from, thereby eliminating spelling mistakes and other data entry 

errors.  Add as many INNS as necessary to your list. For the purposes of this exercise, we have only added in 

three INNS.  
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STEP 8: Return to your feature overview page, click on your ‘Invasive plant 

species’ polygon layer and make sure ‘Enable attachments’ is on. This will allow 

your users to upload photos of the invasive species to your feature.  

STEP 9: From the overview page, open your feature into a new map. You can 

rename your layer to something simpler by hovering over the layer in the 

contents pane, clicking on the three dots and choosing ‘Rename’. As these layer 

names will appear on your Collector App, the simpler the name the better.  

STEP 10: Hover over the layer name again and click the icon of three shapes in 

order to change the style of your polygons. From the drop-down list of 

attributes, choose your newly created field ‘Invasive plant species name’ and 

change the colours for each species as required. Click ‘Okay’ then ‘Done’.  

STEP 11: Save your map with a recognisable name e.g. INNS Survey into an appropriate folder.  

STEP 12: Click ‘Share on your map’. Here you can choose to share the map with either a group within your 

organisation, your whole organisation or to the wider public. You may be prompted to update the sharing of 

the feature within your map, if so click to do so.  
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STEP 13: Download Collector for ArcGIS onto your phone 

or tablet and sign into the ArcGIS account with your 

normal ArcGIS credentials. You should then be able to see 

the maps which you have access to.  

STEP 14: Open the map which you have just created. If 

you receive the message ‘Allow Collector to access this 

device’s location?’, click to accept this. This phone or 

tablet will then find your location on the map. Collector 

needs a minimum 9 meters GPS accuracy to be able to 

work. Your device may take a few minutes to lock onto 

enough satellites to achieve this accuracy. If you are 

carrying out your survey in a heavily wooded area, this 

accuracy may be more difficult to achieve.  

STEP 15: Once in the field on your survey, you would now be able to start collecting information about the 

location in invasive non-native species. For the purposes of this exercise, we will record the theoretical 

locations of INNS remotely.  

STEP 16:  Pan the map to your survey location, for this example we are using Morland 

Beck in Cumbria. As default, the App will use your current location as the point used 

to collect your first point. If you do not want your current location as the first point of 

your polygon, you can click on the three vertical dots next to your layer name, then 

choose ‘delete selected point’. You will then be able to click anywhere on the map as 

the first point of your polygon.  

STEP 17: Tap on the plus symbol in the bottom right hand side of the App and add 

points to until you have a polygon representing the extent of your block of INNS. If 

you are able to walk around the perimeter of the stand of INNS, then you could use 

the ‘Streaming’ function which will create points as you walk. If you make a mistake, 

you can undo and delete selected points by clicking on the three vertical dots. 

STEP 18: Use either the ‘Take photo’ or ‘Attach’ functions to add either an existing or 

new photo of the block of INNS. Next, choose which plant species it is from the drop-down list e.g. 

Himalayan Balsam. Finally, tap the tick symbol to submit the polygon. If you need to edit the polygon then 

you can do this by clicking on the pencil icon.  

STEP 19: Continue to add polygons until your survey is complete. 
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STEP 20: Your data will upload automatically to ArcGIS Online once your device has an internet connection 

again. It may not upload immediately so you may have to wait.  

STEP 21: It is also possible to add additional fields at a later date. To do this, follow the same process by 

adding a new field in the Data tab of your feature. Call this new field ‘Notes’ and reopen the feature in your 

web map. To get this new field to display as a data input field in the Collector App, click on the three 

vertical dots next to your Feature name in the Contents pane and open ‘Configure Pop-Ups’. Make sure that 

both ‘Display’ and ‘Editable’ are checked in the Configure Attributes settings and then save your map. Next, 

refresh the map on your device. You should then be able to add notes to both new polygons when they are 

created, or you can also retrospectively add notes to existing polygons.  

 

STEP 22: Opening the feature’s attribute table and clicking on the plus symbol in the top right-hand side, 

allows you to add as many of the fields as you require. You will then be able to view all the data collected 

about each polygon and use this for your analysis.  

   

 

Further help and support 

Esri have produced a range of training materials on the use of ArcGIS Collector. An introductory video 

tutorial can be accessed HERE. 

 

 

 

https://www.esri.com/training/catalog/57eb17c0ee85c0f5204b9c14/collector-for-arcgis%3A-an-introduction/
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 MANAGING YOUR ORGANISATIONAL ACCOUNT 

In this session you will learn about: 

• Managing your content 

• Brief introduction to Groups – how to set up your own group 

• Setting up your home page and Gallery 

• Managing credits 

• Managing users and licenses 

NB: This session is designed for those people who will be administrating their organisation’s account. If you 

do not have administration rights on your account, you may not be able to see or access the functions 

described in this section. 

Managing your content 
From your contents window you can launch maps and applications, open the item details, launch the 

configure app builders, move items between folders, change ownership to another member of your 

organisation, check and change sharing settings, and delete items. 

 

 

 

 

 

 

 

 

 

 

An introduction to groups – setting up a new group 
Groups are a useful way to share data, maps and apps among your organisation and with external partners 

who are also using AGOL. In this example we are going to set up a Showcase Gallery Group which you can 

then use to feature your most important content on you AGOL Home Page. 

STEP 1: Click ‘Groups’ on the top AGOL header bar and then click ‘Create New Group’. 

STEP2: Then enter the follow details into the form 

• Add an image for your group such as your organisation’s logo. If you don’t have an image to hand 

you can leave blank and add later 

• Give your group a name such as ‘[Org Name] Showcase’ 
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• Enter a brief description e.g. ‘Showcase apps from [Org Name]’ 

• A key word tag such as your organisation’s name 

• It is suggested that you leave the remaining default settings in place 

STEP 3: Click ‘Create Group’. This will open the Item Details page for the group. You can now click the ‘Invite 

Users’ button to search for and invite people to join your group. Important: To find external users in the 

search box their user profile must be set to public!! We will come to that in a minute. 

STEP 4: Click ‘Content’ on the main header bar to return to your contents window. Open the AGOL Training 

folder. Select one of your Web Mapping Applications such as Flooding in the River Tees. Click ‘Share’ and 

then ‘Access’ and you will see how you can add a web-mapping application to your new group. 

For help managing groups visit https://doc.arcgis.com/en/arcgis-online/administer/manage-groups.htm  

Setting up your home page and gallery 
Setting up your home page and galley can be a good way of highlighting featured content within your AGOL 

portal and introducing people to your mapping content. You can see the Rivers Trust Home Page at 

https://theriverstrust.maps.arcgis.com/home/index.html  

You edit your Home Page via the Organization Tab on the AGOL Header bar. Open this tab then click ‘Edit 

Settings’ (NB: You need to be an administrator on your account to do this) 

In the General tab you can add your organisation’s logo, a description, set your URL, and define a shared 

colour theme that will automatically apply to all new apps. 

In the Home Page tab, you can set your background, add a banner image to your home page, and select a 

group e.g. your new showcase group, whose content will be featured on the home page carousel 

In the Gallery tab you can similarly select a group whose content will appear in your organisation’s galley.  

For help configuring your Organisation’s account see https://doc.arcgis.com/en/arcgis-

online/administer/configure-site.htm  

Managing Credits 
You receive some free credits for every non-profit ArcGIS Desktop license that you hold. You can see the 

amount of credits your organisation has remaining at any one time from within the organisation tab on the 

main AGOL header bar. These credits should be enough if all you want to do is create a small number of 

maps and apps using data mainly published from the CaBA Group, Living Atlas or other organisations. You 

will also be able to publish a number of small local datasets within this amount. However, if you want to 

start publishing and storing large complex datasets or undertaking analysis online you may start to use 

more credits. An overview of service credits can be found at 

http://www.esri.com/software/arcgis/arcgisonline/credits  

 

 

https://doc.arcgis.com/en/arcgis-online/administer/manage-groups.htm
https://theriverstrust.maps.arcgis.com/home/index.html
https://doc.arcgis.com/en/arcgis-online/administer/configure-site.htm
https://doc.arcgis.com/en/arcgis-online/administer/configure-site.htm
http://www.esri.com/software/arcgis/arcgisonline/credits
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To see how your organisation is using credits click ‘View Status’ from within the Credits box. This will open 

an analytics report where you can find out how many credits you are using on a weekly/monthly basis, who 

is using them and what they are using them for. It is most likely credits will be being used by storage of data 

which is why it is important to keep on top of your content. You can now view and download a table within 

the View Status section showing the storage requirements of each dataset.   

For more information on using the view status analytics see https://doc.arcgis.com/en/arcgis-

online/administer/view-status.htm  

Managing Users and Licences 
You can edit your own or if you are an administrator you can edit other people’s user profiles within your 

organisation. The main reasons to do this is are to check that the user profile is public so that they can be 

added to groups and to change 

the name and email address on 

the account should a member of 

staff leave the organisation. 

STEP 5: To edit your user profile 

click the ‘Members’ tab on the 

 

 

https://doc.arcgis.com/en/arcgis-online/administer/view-status.htm
https://doc.arcgis.com/en/arcgis-online/administer/view-status.htm
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header bar. Then click the 3 dot options symbol to the right of your username and select view profile.  

 

STEP 6: Check that the ‘Who can see your 

profile?’ is set to Everyone (public).  

Click edit my profile to make changes. You will 

see that the one thing you can’t change is the 

username of the account. For this reason we 

suggest new accounts within your organisation 

are set up using generic usernames such as 

TeesRT_GISUser or TeesRT_Fisheries. This 

makes it much easier to transfer accounts 

should staff members change. 

From the Organisation tab you can also invite new members to join your account, for example, if you buy a 

new non-profit license for a new member of staff and manage access to your ArcGIS Pro licenses. More 

information is available via the ESRI Help pages below 

Inviting Users: https://doc.arcgis.com/en/arcgis-online/administer/invite-users.htm  

Managing Users: https://doc.arcgis.com/en/arcgis-online/administer/manage-members.htm  

Managing Licenses: https://doc.arcgis.com/en/arcgis-online/administer/manage-licenses.htm  

 

Tracking content use 
ArcGIS Online collates some basic user statistics based on the number of views a particular app, map or 

dataset has had within a defined time period.  

STEP 7: To view these go to your contents page and click on the item you are interested in to open the Item 

Details page.  

https://doc.arcgis.com/en/arcgis-online/administer/invite-users.htm
https://doc.arcgis.com/en/arcgis-online/administer/manage-members.htm
https://doc.arcgis.com/en/arcgis-online/administer/manage-licenses.htm
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STEP 8: Then click on usage on the header bar. This will bring up a usage chart showing the number of views 

within in selected time period. You can vary the time period using the dropdown box to the right.  

 

If your Story Map consists of several Apps and Maps embedded into one overarching app you can drill down 

to find out this information for each individual map and app, giving you more information on which parts of 

your Story Map are being viewed most often.  

 

You can now also add Google Analytics to StoryMaps created using the new template. This blog from ESRI 

provides more details on how to do this https://www.esri.com/arcgis-blog/products/arcgis-

storymaps/constituent-engagement/track-your-story-map-performance-using-google-analytics-beta/  

 

https://www.esri.com/arcgis-blog/products/arcgis-storymaps/constituent-engagement/track-your-story-map-performance-using-google-analytics-beta/
https://www.esri.com/arcgis-blog/products/arcgis-storymaps/constituent-engagement/track-your-story-map-performance-using-google-analytics-beta/
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STEP 9: To find out which is the most 

popular content within your 

organisations AGOL account go to 

Organisation on the header bar and 

select status. Then click the content tab 

and scroll to the bottom of the page to 

see trending and most popular content.  

If your Story Map is embedded within a 

web-site you could also use Google 

Tracking on that site and web-page to 

find out additional user information 

such as where users are coming from 

and how they have found your site e.g. 

search engine, social media link etc…

  

NOTE: The new StoryMaps will have an 

additional function allowing you to add 

a Google Tracking ID directly within 

your Story Map. 

 

 

 

 

 

 

Further Support & Training 
Online Tutorial: Setup an ArcGIS Organization. In this lesson, you'll complete a basic ArcGIS Online site 

configuration. You'll customize the home page, share content, and add members with limited privileges. 

You'll also budget credits for members and assign them licenses to use ArcGIS apps. https://bit.ly/2lA4aD4 

 

 

 

 

 

 

 

 

 

https://bit.ly/2lA4aD4
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 KEY LINKS AND RESOURCES 

We will give you a digital version of these pages  

CaBA Open Data Portal: https://data.catchmentbasedapproach.org/ 

ESRI Classic StoryMaps: https://storymaps-classic.arcgis.com/en/ 

ESRI New Generation StoryMaps: https://storymaps.arcgis.com 

ESRI Check for StoryMap updates: https://doc.arcgis.com/en/arcgis-storymaps/reference/release-notes.htm 

Administrating your AGOL account: 

https://doc.arcgis.com/en/arcgis-online/administer/get-started-with-administration.htm  

https://bit.ly/2lA4aD4 

AGOL credits: 

https://www.esri.com/software/arcgis/arcgisonline/credits  

Subscriber and Premium content help: 

https://blogs.esri.com/esri/arcgis/2015/07/17/using-subscriber-content-in-web-apps/  

Publishing tile map services: 

http://doc.arcgis.com/en/arcgis-online/share-maps/publish-tiles.htm  

Learning about Web AppBuilder: 

https://doc.arcgis.com/en/web-appbuilder/ 

Learning ArcGIS Pro: 

https://www.esri.com/training/catalog/590901ecdb250232197d2326/going-pro:-arcgis-pro-essentials-for-

arcmap-users/  

Using Arcade for advanced labelling and symbology: 

https://developers.arcgis.com/arcade/ 

https://www.youtube.com/watch?v=OMF9Tr-y7YI  

ArcGIS Survey123:  

https://survey123.arcgis.com/  

ArcGIS Dashboards:  

https://www.esri.com/en-us/arcgis/products/arcgis-dashboards/overview  

ArcGIS Collector:  

https://www.esri.com/en-us/arcgis/products/arcgis-collector/overview  

Hosted Views:  

https://doc.arcgis.com/en/arcgis-online/share-maps/create-hosted-views.htm 

https://data.catchmentbasedapproach.org/
https://storymaps-classic.arcgis.com/en/
https://storymaps.arcgis.com/
https://doc.arcgis.com/en/arcgis-online/administer/get-started-with-administration.htm
https://bit.ly/2lA4aD4
https://www.esri.com/software/arcgis/arcgisonline/credits
https://blogs.esri.com/esri/arcgis/2015/07/17/using-subscriber-content-in-web-apps/
http://doc.arcgis.com/en/arcgis-online/share-maps/publish-tiles.htm
https://doc.arcgis.com/en/web-appbuilder/
https://www.esri.com/training/catalog/590901ecdb250232197d2326/going-pro:-arcgis-pro-essentials-for-arcmap-users/
https://www.esri.com/training/catalog/590901ecdb250232197d2326/going-pro:-arcgis-pro-essentials-for-arcmap-users/
https://developers.arcgis.com/arcade/
https://www.youtube.com/watch?v=OMF9Tr-y7YI
https://survey123.arcgis.com/
https://www.esri.com/en-us/arcgis/products/arcgis-dashboards/overview
https://www.esri.com/en-us/arcgis/products/arcgis-collector/overview
https://doc.arcgis.com/en/arcgis-online/share-maps/create-hosted-views.htm
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Drop-down menus: 

http://communityhub.esriuk.com/technicalsupport/2013/8/22/how-to-create-drop-down-menus-for-

populating-attributes.html 

 

Further ESRI Training: 

http://learn.arcgis.com/en/          

https://www.esri.com/training/  

 

Further CaBA Training: 

How to add CaBA data layers to a map and filter https://player.vimeo.com/video/214846470 

How to run the myScimap model and export the data to AGOL. https://vimeo.com/185400798   

We will record more video tutorials soon – keep an eye on https://data.catchmentbasedapproach.org/ 

 

Additional useful links: 

DEFRA Data Services Platform: https://environment.data.gov.uk/ 

Lle Geo-Portal: http://lle.gov.wales/home  

Natural England Open Data site http://naturalengland-defra.opendata.arcgis.com/ 

Working with Natural Processes Evidence Base: 

https://www.gov.uk/government/publications/working-with-natural-processes-to-reduce-flood-risk 

National River Flow Archive: https://nrfa.ceh.ac.uk/ 

Batch grid reference converter: http://gridreferencefinder.com/batchConvert/batchConvert.php     

 

 

http://communityhub.esriuk.com/technicalsupport/2013/8/22/how-to-create-drop-down-menus-for-populating-attributes.html
http://communityhub.esriuk.com/technicalsupport/2013/8/22/how-to-create-drop-down-menus-for-populating-attributes.html
http://learn.arcgis.com/en/
https://www.esri.com/training/
https://player.vimeo.com/video/214846470
https://vimeo.com/185400798
https://data.catchmentbasedapproach.org/
https://environment.data.gov.uk/
http://lle.gov.wales/home
http://naturalengland-defra.opendata.arcgis.com/
https://www.gov.uk/government/publications/working-with-natural-processes-to-reduce-flood-risk
https://nrfa.ceh.ac.uk/
http://gridreferencefinder.com/batchConvert/batchConvert.php

